WOODWARD

APECS® 500 Electronic Engine Speed Governing System

User Manual

Manual SE-4107
WARNING
Read this entire manual and all other publications pertaining to the work to be performed before installing, operating, or servicing this equipment. Practice all plant and safety instructions and precautions. Failure to follow instructions can cause personal injury and/or property damage.

The engine, turbine, or other type of prime mover should be equipped with an overspeed shutdown device to protect against runaway or damage to the prime mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover control system. An overtemperature or overpressure shutdown device may also be needed for safety, as appropriate.

CAUTION
To prevent damage to a control system that uses an alternator or battery-charging device, make sure the charging device is turned off before disconnecting the battery from the system.

Electronic controls contain static-sensitive parts. Observe the following precautions to prevent damage to these parts.
- Discharge body static before handling the control (with power to the control turned off, contact a grounded surface and maintain contact while handling the control).
- Avoid all plastic, vinyl, and Styrofoam (except antistatic versions) around printed circuit boards.
- Do not touch the components or conductors on a printed circuit board with your hands or with conductive devices.

IMPORTANT DEFINITIONS
WARNING—indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

CAUTION—indicates a potentially hazardous situation which, if not avoided, could result in damage to equipment.

NOTE—provides other helpful information that does not fall under the warning or caution categories.
# Contents

**Electrostatic Discharge Awareness**................................. 1

**CHAPTER 1. GENERAL INFORMATION**.............................. 2
  System Basics .................................................................. 2
  System Components ....................................................... 3
  APECS Controller .......................................................... 3
  Speed Sensor .................................................................. 4
  Actuator ......................................................................... 4
  Linkage .......................................................................... 4
  All-purpose Calibration Tool (ACT) ................................... 5

**CHAPTER 2. INSTALLING THE HARDWARE** ....................... 6
  Wiring Guidelines .......................................................... 6
  Wiring Length .................................................................. 7
  Controller Installation .................................................... 8
  Controller Wiring .......................................................... 8
  Controller Pinout ........................................................... 9
  Speed Sensor Installation ................................................ 10
  Magnetic Pickup Wiring ................................................ 10
  Actuator & Linkage Installation ........................................ 10

**CHAPTER 3. CALIBRATING APECS FEATURES** .................. 11
  Calibration Guide .......................................................... 11
  Safety Precautions ....................................................... 11
  Manual Calibration ....................................................... 11
  All-purpose Calibration Tool Set-up ......................... 12
  Calibration Categories ................................................ 13
  Calibrating an APECS Unit .......................................... 13
  Saving a Calibration Set to File .................................... 14
  Calibrating an APECS Unit with a Saved Calibration File ... 14
  Understanding APECS Calibration Parameters .............. 15
  Frequently Asked Questions ......................................... 15
  List of Parameters ....................................................... 16
  Governor Gain Calibration Parameters ...................... 17
  PID Gains Adjustment ................................................. 17
  PID Gain Settings Response Plots ................................. 17
  Engine Set Speed Calibration Parameters ................... 18
  Speed Input Configuration Parameters ....................... 19
  Engine Start Calibration Parameters ........................... 19
  Diagnostics Calibration Parameters ............................. 20
  Overspeed / Underspeed Protection .............................. 20
  Actuator Output Calibration Parameters .................... 21
  Calibration Setup & Configuration Parameters Flowchart . 22

**CHAPTER 4. ACT OPERATION** ......................................... 24
  ACT Installation .......................................................... 24
  ACT Kit Contents ......................................................... 24
  Set-up Requirements ................................................... 24
  Hardware Set-up ........................................................ 24
  Software Set-Up .......................................................... 25
  Basic ACT Operation .................................................. 26
  Running the ACT Software .......................................... 26
  Progress Display Screen .............................................. 26
  Moving Around the Software ....................................... 26
  ACT Menus & Options ................................................ 27
  ACT Menu Structure .................................................... 27
  File Menu ...................................................................... 27
# APECS® 500 Electronic Engine Speed Governing System Manual SE-4107

---

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>27</td>
</tr>
<tr>
<td>Save APECS Cal to File</td>
<td>28</td>
</tr>
<tr>
<td>View Cal File Comments</td>
<td>29</td>
</tr>
<tr>
<td>View Text File</td>
<td>29</td>
</tr>
<tr>
<td>Convert Commands</td>
<td>30</td>
</tr>
<tr>
<td>Convert APECS Cal to Text</td>
<td>30</td>
</tr>
<tr>
<td>Convert Cal File to Text</td>
<td>30</td>
</tr>
<tr>
<td>Convert Cal File to Strategy</td>
<td>30</td>
</tr>
<tr>
<td>Calibrate Menu</td>
<td>31</td>
</tr>
<tr>
<td>Change APECS Calibration</td>
<td>31</td>
</tr>
<tr>
<td>Download Cal File to APECS</td>
<td>32</td>
</tr>
<tr>
<td>Compare APECS Cal to File Cal</td>
<td>33</td>
</tr>
<tr>
<td>Change APECS Password</td>
<td>34</td>
</tr>
<tr>
<td>APECS Calibration Wizard</td>
<td>36</td>
</tr>
<tr>
<td>Monitor Menu</td>
<td>37</td>
</tr>
<tr>
<td>Parameter View</td>
<td>37</td>
</tr>
<tr>
<td>Parameter Plot</td>
<td>38</td>
</tr>
<tr>
<td>Display Faults</td>
<td>39</td>
</tr>
<tr>
<td>Control Strategy</td>
<td>40</td>
</tr>
<tr>
<td>Parameter List</td>
<td>40</td>
</tr>
<tr>
<td>Configure Menu</td>
<td>41</td>
</tr>
<tr>
<td>Configure Serial Port</td>
<td>41</td>
</tr>
<tr>
<td>Help Menu</td>
<td>42</td>
</tr>
<tr>
<td>Help Topics</td>
<td>42</td>
</tr>
<tr>
<td>About ACT</td>
<td>42</td>
</tr>
<tr>
<td>User’s Manual</td>
<td>42</td>
</tr>
<tr>
<td>CHAPTER 5. TROUBLESHOOTING</td>
<td>43</td>
</tr>
<tr>
<td>General Checklist</td>
<td>43</td>
</tr>
<tr>
<td>Fault Codes</td>
<td>43</td>
</tr>
<tr>
<td>Glossary of Technical Terms</td>
<td>45</td>
</tr>
<tr>
<td>CHAPTER 6. SERVICE OPTIONS</td>
<td>46</td>
</tr>
<tr>
<td>Product Service Options</td>
<td>46</td>
</tr>
<tr>
<td>Replacement/Exchange</td>
<td>46</td>
</tr>
<tr>
<td>Flat Rate Repair</td>
<td>47</td>
</tr>
<tr>
<td>Flat Rate Remanufacture</td>
<td>47</td>
</tr>
<tr>
<td>Returning Equipment for Repair</td>
<td>47</td>
</tr>
<tr>
<td>Packing a Control</td>
<td>47</td>
</tr>
<tr>
<td>Return Authorization Number</td>
<td>48</td>
</tr>
<tr>
<td>Replacement Parts</td>
<td>48</td>
</tr>
<tr>
<td>How to Contact Woodward</td>
<td>48</td>
</tr>
<tr>
<td>Engineering Services</td>
<td>49</td>
</tr>
<tr>
<td>Technical Assistance</td>
<td>50</td>
</tr>
</tbody>
</table>
Electrostatic Discharge Awareness

All electronic equipment is static-sensitive, some components more than others. To protect these components from static damage, you must take special precautions to minimize or eliminate electrostatic discharges.

Follow these precautions when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static electricity on your body to ground by touching and holding a grounded metal object (pipes, cabinets, equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing made of synthetic materials. Wear cotton or cotton-blend materials as much as possible because these do not store static electric charges as much as synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam cups, cup holders, cigarette packages, cellophane wrappers, vinyl books or folders, plastic bottles, and plastic ash trays) away from the control, the modules, and the work area as much as possible.

4. Do not remove the printed circuit board (PCB) from the housing unless absolutely necessary. If you must remove the PCB from the housing, follow these precautions:

   - Do not touch any part of the PCB except the edges.
   - Do not touch the electrical conductors, the connectors, or the components with conductive devices or with your hands.
   - When replacing a PCB, keep the new PCB in the plastic antistatic protective bag it comes in until you are ready to install it. Immediately after removing the old PCB from the control cabinet, place it in the antistatic protective bag.

CAUTION
To prevent damage to electronic components caused by improper handling, read and observe the precautions in Woodward manual 82715, Guide for Handling and Protection of Electronic Controls, Printed Circuit Boards, and Modules.
Chapter 1.
General Information

System Basics

APECS 500 is a single speed electronic engine governor that combines the convenience of manual adjustments with the flexibility of a computer-based calibration tool. Electrical connections consist of six wires to battery, actuator and magnetic engine speed pickup via a Euro-style terminal strip. For most applications, APECS 500 can be connected and adjusted with simple hand tools. For more advanced features, the calibration tool provides user-friendly access.

As shipped from the factory, APECS 500 can be manually adjusted for stable operation on most applications that supply a mag pickup frequency of 2500 to 5000 Hz. Optionally, the user may attach the standard APECS calibration tool (ACT) to gain access to a number of user-adjustable features including:

- Frequency Range (200-15,000 Hz)
- Synchronized speed sampling
- Proportional, Integral and Derivative gains (Gain potentiometer affects all three)
- Overspeed shutdown and delay
- Underspeed shutdown and delay
- Crank-to-run transition speed
- Warmup speed and time
- Startup gains
- Offset to actuator command
- Battery voltage compensation

In the event of a fault, APECS 500 provides helpful diagnostic information with an on-board status lamp. Additionally, the ACT may be used to access current and historic fault codes.

APECS is an acronym for Advanced Proportional Engine Control System. It provides a means of controlling engine speed by adjusting the fuel control lever with an actuator. The heart of the system is a powerful microcontroller that processes the signal received from a speed sensor and compares it to the desired speed setting.

The output of the controller is a pulse-width modulated (PWM) signal that drives a precision proportional actuator connected to the engine’s fuel control lever. The actuator converts the signal to an output shaft position, proportional to the duty cycle of the pulse-width modulated signal.

APECS 500 provides isochronous engine governing (i.e., engine speed is maintained at the commanded setting, regardless of load) through a wide speed range. APECS is suitable for use on both compression ignition (diesel) and spark ignition (gasoline, CNG, LPG) engines.
Woodward developed the APECS system for a variety of on- and off-highway applications. Typical applications include generator sets, compressors, construction machinery and farm vehicles.

**WARNING**
An overspeed shutdown device, independent of the APECS system, should be provided to prevent loss of engine control that may cause personal injury or equipment damage.

![Figure 1. APECS Engine Control System](image)

**System Components**

The three components required to install an APECS 500 governor on an engine are the APECS 500 controller, speed sensor, and actuator. Each component contributes to the overall performance of the system and shortcomings in any of the components will detract from total system performance. Optionally, the All-purpose Calibration Tool (ACT) may be used to customize operation.

**APECS Controller**

The APECS 500 series controller is a single-speed electronic engine governor that provides a means of controlling and limiting engine speed by adjusting the fuel control lever with a proportional actuator. APECS 500 will maintain fixed engine RPM regardless of load provided that the engine’s available power is not exceeded (i.e., isochronous operation).

The APECS 500 controller has a multi-turn potentiometer for speed adjustment and a single turn potentiometer for gain adjustment. A serial interface is provided for additional adjustments with the ACT. The controller has six Euro-style screw terminals for:

- Battery Positive and Negative (9-30 VDC). Reverse voltage protected.
- Magnetic Pickup (MPU) Positive and Negative (2 VAC minimum at 1000 Hz)
Provided that the MPU frequency is compatible with the engine application, setup consists of the following:

1. Set gain potentiometer to center of travel (5). The speed set potentiometer should be set to the minimum speed (fully counterclockwise) position.
2. Apply power to controller. The status LED should turn on for one second, indicating normal operation.
3. Crank engine. The status LED should turn on continuously indicating a good speed signal from the MPU. If not, check the MPU installation and wiring. If LED immediately begins to flash a two code (indicating engine overspeed), increase the desired speed setting by turning the multi-turn speed set potentiometer several turns clockwise. Repeat this crank and adjust process until the engine starts.
4. Adjust speed setpoint until desired speed is achieved. If the engine speed will not settle down, turn the gain potentiometer counterclockwise until stable performance results.
5. Once the desired speed setpoint is achieved, adjust gain for optimal performance at all loads. In general, this amounts to increasing the gain as much as possible without inducing oscillation under any load.

**Speed Sensor**

APECS 500 monitors engine speed continuously using a magnetic pickup (MPU) which detects the passing of teeth on an engine driven gear (e.g., flywheel). The frequency of the voltage generated by the MPU is proportional to engine RPM.

**Actuator**

The actuator converts a pulse-width modulated signal received from the controller to an output shaft position proportional to the duty cycle of the pulse-width modulated signal.

The actuator is mounted on the engine and connected to the control lever by a mechanical linkage.

NOTE: On spark ignition engines, the control lever is usually the throttle lever. On compression ignition engines (diesels), the control lever is usually one of the mechanical governor levers (either shutoff or governor).

**Linkage**

The linkage connects the actuator shaft to the engine control lever. A good linkage allows for misalignments and contributes to accurate, stable and responsive performance with minimal play or friction.
All-purpose Calibration Tool (ACT)

ACT is a PC (personal computer) based software calibration and monitoring tool. ACT is designed specifically for use with engines equipped with the APECS 500 controller. The tool can be run on any IBM compatible computer that meets the requirements listed in “ACT Installation” in Chapter 4.

Once the APECS 500 controller has been programmed, ACT may be disconnected. The APECS 500 unit will continue to operate normally with ACT either connected or disconnected.

NOTE
The scope of this manual does not include selection and installation of speed sensors, actuators, or linkages that Woodward offers for use with the APECS system. Information is available on our website at www.woodward.com.

NOTE
The need for sub-components such as switches and potentiometers is application dependent. Please contact Woodward for information specific to your application.
Chapter 2.
Installing the Hardware

Take adequate protection to ensure personal and equipment safety and follow the suggested installation sequence given below:

Install main components:
Review Wiring page 6
Controller page 8
Speed Sensor page 10
Actuator & Linkage page 10

Wiring Guidelines

APECS 500 has six Euro-style terminals for external connections. To use:

1. Loosen the terminals with a small blade screwdriver
2. Strip wire
3. Insert wire into terminal hole
4. Tighten terminal with a small blade screwdriver

Guidelines

1. Refer to Figures 2 & 3 and Tables 1 & 2 to install the system and subcomponents.
2. Mount the unit in a location where the effects of vibration and temperature are within the specified range. Operating temperature: -40°F to +185°F (-40°C to +85°C); vibration: 6 G's from 40 to 2000 Hz. (See Figure 2 for controller dimensions.)
3. Power leads are to be connected directly to a switched power source (i.e., battery). Use of a 10 amp, slow-blow fuse is recommended in the battery (positive) wire.
4. Use shielded cable for external speed signal source. Shields should be connected to the battery ground wire at one end only.
5. Use of convoluted tubing, conduit or other wire shielding is recommended to minimize the likelihood of mechanical damage to wires.
   Avoid routing wires near sharp edges or near locations that can cause the wires to be “pinched” or damaged.
6. Use proper gauges and lengths of wire as shown in Table 1. Wire insulation should be appropriate for engine applications.
   Excessive length or inadequate gauge can cause increased wire resistance that can limit the current to the actuator and prevent full actuator travel.
7. Increased electrical resistance can also result from poor wiring techniques. It is important to use good quality terminations and proper crimping technique during wiring.

Terminations must be impervious to moisture to prevent shorts and corrosion.

**Wiring Length**

Excessive resistance in the wiring will result in insufficient force from the actuator. Such increased resistance can result from too much wire length, inadequate wire gauge, or poor connections.

The following table shows the recommended gauges and maximum lengths of connecting wires for different size APECS actuators. Wire length is the total length (to and from) used to connect the actuator to the controller and the controller to the system power.

**NOTE:** All system wiring should be twisted pair and shielded (preferably foil shielded).

<table>
<thead>
<tr>
<th>ACTUATOR*</th>
<th>AWG 14 (2.50 mm²)</th>
<th>AWG 16 (1.50 mm²)</th>
<th>AWG 18 (1.00 mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0175</td>
<td>66 ft (20 m)</td>
<td>33 ft (10 m)</td>
<td>22 ft (6.7 m)</td>
</tr>
<tr>
<td>0250</td>
<td>46 ft (14 m)</td>
<td>23 ft (7 m)</td>
<td>15 ft (4.6 m)</td>
</tr>
<tr>
<td>0300</td>
<td>46 ft (14 m)</td>
<td>23 ft (7 m)</td>
<td>15 ft (4.6 m)</td>
</tr>
</tbody>
</table>

(*) The controller has a working range of 9-30 VDC. However, the actuator must be selected for either 12 or 24 VDC charging system.
Controller Wiring

The controller can be installed in the engine compartment (maximum temperature 185°F / 85°C).

Figure 2. APECS 500 Dimensions

Table 2. Controller Wiring

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>PIN INFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actuator Output</td>
<td>ACT+ (Pin 3), ACT- (Pin 4)</td>
</tr>
<tr>
<td>Battery</td>
<td>VBAT (Pin 2), GND (Pin 1)</td>
</tr>
<tr>
<td>Speed Signal Input</td>
<td>RPM+ (Pin 5), RPM- (Pin 6)</td>
</tr>
<tr>
<td>ACT Connector</td>
<td>RCV (Pin 4), TXD (Pin 3), GND2 (Pin 1)</td>
</tr>
</tbody>
</table>
Controller Pinout

Use the diagram below to connect your APECS controller to battery power, the mag pickup, actuator, and ACT.

![Diagram of APECS 500 Wiring Diagram]

Figure 3. APECS 500 Wiring Diagram
Speed Sensor Installation

Magnetic Pickup Wiring

Installed opposite an engine driven gear such as the flywheel, the mag pickup transmits a signal each time the magnetic flux path across the pole is interrupted by a gear tooth. The mounting of the sensor unit must be rigid; excessive vibration can cause erroneous signals and unreliable performance.

Connect the speed sensor to the two RPM inputs on the controllers. Most sensors do not have a positive or negative side and can be connected either way. Use twisted pair shielded wire for all speed sensor wiring. The shield should be grounded at the controller only.

![Speed Sensor Wiring Diagram](image)

Figure 4. Speed Sensor Wiring

Actuator & Linkage Installation

1. Select an actuator with sufficient force to move the fuel control lever from minimum to maximum fuel position. Make certain that the actuator can reach maximum fuel position when the actuator is warm, as some reduction in force may occur. The controller has a working range of 9-30 VDC. However, the actuator must be selected for either a 12 or 24 VDC charging system.

2. Select or design a bracket that correctly aligns the actuator shaft and control lever and is able to withstand the vibration level of the engine or application.

3. The linkage must have minimal friction, binding and backlash. The bracket and linkage should be designed to use as much of the actuator travel as possible.

4. Fasten actuator to bracket and bracket to engine. Attach necessary linkage between actuator shaft and fuel control lever. Move linkage end-to-end to confirm correct travel and adjust length if needed.

5. Connect actuator wires (use twisted pair with more than 1 twist per inch). Actuator travel should be adjusted to assure both maximum (start fuel or rated load) and minimum (shutdown or idle) positions.

![Actuator Wiring Diagram](image)

Figure 5. Actuator Wiring

NOTE: It is beyond the scope of this manual to discuss detailed actuator selection and installation procedures for all possible applications. Please contact the factory for specific information concerning your application.
Chapter 3. Calibrating APECS Features

Calibration Guide

This section explains the procedures for calibrating (configuring and adjusting) the various APECS 500 features to work with your application.

Before proceeding, make sure you have completed the installation of all the required hardware for your system and are familiar with using the All-purpose Calibration Tool (ACT). See Chapter 4 for details on ACT.

Engine speed and master gain can be calibrated manually without using the ACT by adjusting the two potentiometers on the front of the APECS 500 controller.

Optimal performance is best achieved by using the ACT to individually adjust Proportional, Integral and Derivative gains. More advanced features are also accessible by using the ACT.

If APECS 500 is to be used on a variety of engines or applications, it may be possible to develop unique calibrations for each one, download before installation, and then do any fine tuning using the manual adjustments.

Safety Precautions

The APECS 500 is a user configurable engine speed governor and will follow your settings and commands immediately. Please be aware of this when calibrating and entering values in the unit.

It is possible to enter values in the APECS unit that are in excess of what the engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the APECS or the ACT. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment or application.

WARNING
An overspeed shutdown device, independent of the APECS system, should be provided to prevent loss of engine control that may cause personal injury or equipment damage.

Manual Calibration

APECS 500 is equipped with two manually adjustable potentiometers:

- **Set Speed Potentiometer**: The user may manually adjust engine-operating speed using the set speed potentiometer. This is a multi-turn potentiometer requiring 20-30 turns to cover the full range of operating speeds. The potentiometer has an internal clutch to prevent overturning. The range of speeds commanded is adjustable using the ACT. Due to the resolution of the internal digital electronics, it may not be possible to adjust operation to the exact frequency (e.g. 60.1Hz vs 60 Hz).

- **Master Gain Potentiometer**: The user may manually adjust control gain using the single-turn master gain potentiometer. Master gain influences Proportional, Integral and Derivative gain. The range of gains commanded is adjustable using the ACT.
Provided that the MPU frequency is compatible with the engine application, setup consists of the following:

1. Set gain potentiometer to center of travel (5). The speed set potentiometer should be set to the minimum speed (fully counterclockwise) position.

2. Apply power to controller. The status LED should turn on for one second, indicating normal operation.

3. Crank engine. The status LED should turn on continuously indicating a good speed signal from the MPU. If not, check the MPU installation and wiring. If LED immediately begins to flash a two code (indicating engine overspeed), increase the desired speed setting by turning the multi-turn speed set potentiometer several turns clockwise. Repeat this crank and adjust process until the engine starts.

4. Adjust speed setpoint until desired speed is achieved. If the engine speed will not settle down, turn the gain potentiometer counterclockwise until stable performance results.

5. Once the desired speed setpoint is achieved, adjust gain for optimal performance at all loads. In general, this amounts to increasing the gain as much as possible without inducing oscillation under any load.

6. If additional fine tuning is required, connect the ACT and adjust.

All-purpose Calibration Tool Set-up

To connect your PC to the APECS 500 use the cable provided with the calibration tool kit. This cable has a DB-9 connector on one end and a four-pin white plastic Molex connector on the other end.

Connect one end of the RS-232 cable to your PC’s COM port. Connect the other end of the cable to the control module.

NOTE: The APECS 500 must be powered up in order for ACT to operate.

For further information on installation and operation of the All-purpose Calibration Tool (ACT) refer to Chapter 4.

Figure 6. ACT System Set-up
Calibration Categories

To incorporate any of the programmable features in your system, a set of parameters associated with each feature must be calibrated using the calibration tool (ACT). These parameters are grouped under various categories under the Calibrate Menu in ACT. (Refer to Table 3 below.)

Table 3. Calibration Categories and Features

<table>
<thead>
<tr>
<th>CALIBRATION CATEGORY</th>
<th>FEATURES AVAILABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Governor Gain</td>
<td>PID gain settings</td>
</tr>
<tr>
<td>Engine Set Speed</td>
<td>Range of commanded speeds</td>
</tr>
<tr>
<td>Speed Input</td>
<td>Speed input calibration</td>
</tr>
<tr>
<td>Engine Start</td>
<td>Crank duty cycle</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Overspeed/underspeed protection</td>
</tr>
<tr>
<td>Actuator Output</td>
<td>Actuator offset</td>
</tr>
</tbody>
</table>

Calibrating an APECS Unit

Once the system set-up is complete it is fairly easy to calibrate an APECS 500 controller.

Before proceeding with calibration, please ensure that the controller unit is connected to the COM port and powered.

Follow the steps below for calibrating your APECS controller unit.

1. If an icon for the calibration tool exists, double click on it to start the ACT software.
2. If no icon exists, click on the Start button, highlight “Programs,” find the ACT software and click to start it.
3. Make sure the COM port designation in ACT matches the serial port on the back of your PC. Follow the procedure outlined in the Configure Menu to change the COM port assignment, if needed.
4. The Wizard is an interactive guide to help you get your controller running as quickly as possible. If you wish to use the Wizard for basic calibration, refer to “APECS Calibration Wizard in Chapter 4.”
5. If you do not use the Wizard, calibrate the speed input for the type of speed sensor, PULSES_PER_REV and PULSES_PER_UPDATE. “Refer to Speed Input Configuration Parameters.”
6. Beyond basic calibration, there are many parameters associated with APECS that can help enhance the performance of your engine. Read the section in this chapter on “Understanding APECS Calibration Parameters” and decide on the parameters you would like to adjust.
7. Access “Change APECS Calibration” option from the Calibrate Menu and select the desired parameter from the appropriate category. Adjust the value of the parameter as needed.

8. Repeat Step 4 until all desired parameters have been adjusted and satisfactory engine performance has been achieved.

9. You do not need to save the new calibration settings. All settings are automatically saved in the controller and remain in memory after shutdown.

**Saving a Calibration Set to File**

After satisfactory engine performance is achieved, it is recommended that you save the calibration set to a file.

- A saved file allows you to experiment with other calibration settings and still be able to recall the saved calibration set.
- A saved calibration set can be used for configuring additional APECS units.

**To Save a Calibration Set to File:**

1. Access the File Menu to activate the “Save APECS Cal to File” command.

2. Enter a file name to save the calibration data to a designated file.

3. When prompted to edit the comment list, enter information that will help you keep track of specific engine, application and environment data associated with the file.

4. ACT will save the calibration set and automatically append the file extension “.ACT” to the file name.

**Calibrating an APECS Unit with a Saved Calibration File**

You may wish to calibrate additional APECS units with a saved calibration file for consistent, optimized operation.

**To Calibrate an APECS Unit with a Saved Calibration File:**

1. Access the Calibrate Menu to activate the “Download Cal File to APECS” command.

2. Select the appropriate file to download (refer to the comment list on the right side of the screen to help identify the desired file). Enter password if prompted.

3. ACT will download file calibration to APECS permanent memory.

4. Repeat Steps 1 and 2 if multiple APECS units are to be calibrated.

**NOTE:** The APECS unit must be powered up, but need not be mounted on the engine to carry out the calibration procedure.
Understanding APECS Calibration Parameters

This section provides answers to frequently asked questions about calibration parameters, lists parameters, and provides calibration procedures.

Frequently Asked Questions

What is a calibration parameter?
A parameter is a numerical value that helps the calibrator adjust or set the APECS controller. Once fixed by a calibrator, the parameter is not subject to change while the system is operating. APECS calibration parameters are used not only to adjust and set the controller but also to configure it properly for different applications.

Why do we need to calibrate the APECS system?
APECS 500 can be both manually and computer adjusted. APECS 500 is factory programmed for operation between 2500 and 5000 Hz MPU frequency and with P,I,D gains that should permit stable performance on the majority of applications. For optimal performance, calibration with ACT may be required.

Do I need to calibrate ALL the parameters to make my system work?
No. All parameters are preset to values that will work with many engines and applications. However, it is recommended that you review all settings for your own application.

Is it possible to enter values in APECS in excess of what the application is capable of performing?
Yes. While ACT (the calibration tool) restricts you from entering values outside of the specified range, the range itself is fairly wide and it is possible to enter values in excess of what your application is capable of performing.

For example, it is possible to command engine speeds up to 8192 RPM with ACT. Your engine may or may not be able to operate at this speed. It is also possible to damage the generator or pump attached to your engine by commanding maximum engine speed because while the engine may be capable of performing at the rated RPM, the generator or pump is likely to have a lower RPM rating than the engine.

Furthermore, there are certain parameters that are used to properly configure an application. Entering incorrect values for these parameters will result in improper configuration and may make the engine run at maximum throttle. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment.
# List of Parameters

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
<th>FACTORY CAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Governor Gain Calibration</td>
<td>DERIVATIVE_GAIN</td>
<td>Speed stability</td>
<td>.25</td>
</tr>
<tr>
<td></td>
<td>INTEGRAL_GAIN</td>
<td>Steady state speed</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>PROPORTIONAL_GAIN</td>
<td>Transient response</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>RAMP_DOWN_RATE</td>
<td>Engine speed ramp down rate</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>RAMP_UP_RATE</td>
<td>Engine speed ramp up rate</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_MAX</td>
<td>Maximum engine speed possible with speed pot</td>
<td>5000</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_MIN</td>
<td>Minimum engine speed possible with speed pot</td>
<td>2500</td>
</tr>
<tr>
<td></td>
<td>WARMUP_PCNT</td>
<td>Engine warm up speed</td>
<td>0.8</td>
</tr>
<tr>
<td></td>
<td>WARM_UP_TIME</td>
<td>Time spent at warm up speed</td>
<td>0</td>
</tr>
<tr>
<td>Engine Set Speed Calibration</td>
<td>PULSES_PER_REV</td>
<td>No. of pulses per engine revolution</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>PULSES_PER_UPDATE</td>
<td>No. of pulses until next engine speed update</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CRANK_DUTY_CYCLE</td>
<td>Kickoff duty cycle for open-loop cranking</td>
<td>0.945</td>
</tr>
<tr>
<td></td>
<td>CRANK_2_RUN_PCNT</td>
<td>Percentage of set speed where crank-to-run transition occurs</td>
<td>0.9</td>
</tr>
<tr>
<td>Speed Input Configuration</td>
<td>OVERSPEED_PCNT</td>
<td>Actuator shutdown speed (max)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>OVERSPEED_TIME</td>
<td>Time in msec before setting overspeed fault</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td>UNDERSPEED_PCNT</td>
<td>Actuator shutdown speed (min)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>UNDERSPEED_TIME</td>
<td>Time in msec before setting underspeed fault speed (min)</td>
<td>2500</td>
</tr>
<tr>
<td></td>
<td>UNDERSPEED_RUN_TIME</td>
<td>Run time (sec) before underspeed is checked</td>
<td>10</td>
</tr>
<tr>
<td>Diagnostics Calibration</td>
<td>DUTYCYCLE_OFFSET</td>
<td>Initial value for duty cycle; adjust for improved startup</td>
<td>0.25</td>
</tr>
<tr>
<td>Actuator Output Calibration</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Governor Gain Calibration Parameters

PID Gains Adjustment

PROPORTIONAL_GAIN, INTEGRAL_GAIN and DERIVATIVE_GAIN are all multiplied by the master gain from the single turn potentiometer. In effect, adjusting the master gain adjusts all three. PROPORTIONAL_GAIN, INTEGRAL_GAIN and DERIVATIVE_GAIN are preset to values which should permit stable performance on most applications. To optimize performance, all three gains may be individually tuned using ACT. It is suggested that the master gain potentiometer be set to the middle of travel before adjusting gains using the ACT.

Calibration Parameters Requiring Configuration:

DERIVATIVE_GAIN
Engine speed governor derivative gain (unitless).

Derivative gain is used to improve stability. Increase derivative gain until response has a slight overshoot on load transients.

INTEGRAL_GAIN
Engine speed governor integral gain (unitless).

Integral gain is used to remove steady-state errors. Increase integral gain until speed begins to oscillate, and then decrease until oscillation stops. If oscillations do not occur, bump actuator lever, then decrease integral gain until oscillation stops.

PROPORTIONAL_GAIN
Engine speed governor proportional gain (unitless).

Proportional gain is used to improve response time. A maximum amount of proportional gain should be used while still maintaining stability. Increase proportional gain until speed begins to oscillate, then decrease until oscillation stops. If oscillations do not occur, bump actuator lever, then decrease proportional gain until oscillation stops.

PID Gain Settings Response Plots

ACT allows the user to adjust the P, I, and D gain settings and observe the response directly on screen in the form of a real-time plot. The plots on the following page illustrate the various conditions a user may encounter while tuning an application. Although conditions may vary according to application and nature of load, these plots are typical of what is often observed.

Figures 7–11 illustrate less desirable conditions often encountered while tuning an application and suggest probable causes.

Figure 12 shows a plot of a properly tuned application. Although conditions may vary according to application and nature of load, this plot is typical of what is often desired.
NOTE: Excessive friction and slop in the linkage are primary contributors to poor governor stability. If it is not possible to stabilize engine performance, check smoothness of the linkage.

Engine Set Speed Calibration Parameters

The following calibration parameters require configuration:

**RAMP_DOWN_RATE**
Rate at which command engine speed decreases from one set point to a lower set point (RPM/second)

**RAMP_UP_RATE**
Rate at which commanded engine speed increases from one set point to a higher set point (RPM/second)

**SET_SPEED_MAX**
Highest engine speed command possible with set speed potentiometer

**SET_SPEED_MIN**
Lowest engine speed command possible with set speed potentiometer
WARMUP_PCNT
Engine speed set point used immediately after engine has started running (RPM)

WARMUP_TIME
Length of time to hold engine at warm up speed immediately after engine has started running (seconds). Setting WARMUP_TIME to zero disables the warm up feature.

Speed Input Configuration Parameters

The following calibration parameters require configuration:

PULSES_PER_UPDATE
The number of pulses received by the controller between engine speed calculations and updates.

The fewer the pulses, the faster the update rate and the lower the resolution; the greater the pulses, the greater the averaging effect on calculated engine speed. Factory set to zero

Optimal performance is generally obtained by setting
PULSES_PER_UPDATE = 2 * PULSES_PER_REV / (number of engine cylinders)

Setting PULSES_PER_UPDATE = 0 will provide the fastest update rate, but may detract from performance.

PULSES_PER_REV
The number of teeth on the engine speed pickup wheel (mag pickup input and Hall Effect sensor), or the number of spark pulses per engine rev (ignition input).

To figure out the pulses per revolution, you must determine the kind of speed signal input used on your application:

Magnetic Pickup Input or Hall Effect Sensor
Pulses per revolution = number of teeth on the flywheel

Woodward Mini-Gen® Signal Generator
Pulses per revolution = 0.5 x drive ratio if Mini-Gen is driven at other than crankshaft speed

If readout is desired in Hz instead of RPM, set PULSES_PER_REV = 60. This may detract from performance. PULSES_PER_REV is factory set to 60.

Engine Start Calibration Parameters

The engine cranking parameters control how APECS will drive the actuator during cranking. The following calibration parameters require configuration:

CRANK_2_RUN_PCNT
Speed transition point indicating engine has gone from crank mode to run mode (RPM). This transition is a percentage of the desired RPM commanded by the multi-turn potentiometer.

Crank_2_Run RPM = Desired RPM * CRANK_2_RUN_PCNT

Once engine RPM rises above Crank_2_Run RPM, it is assumed that the engine is in run mode. Default value is 0.9
CRANK_DUTY_CYCLE
The fixed duty cycle used to drive the actuator when the engine is cranking (percent).

May be calibrated to a maximum duty cycle for diesel engines that require full rack for starting, or a minimum duty cycle for some spark-ignition engines that require closed throttle for starting. In run mode, control is closed-loop; the actuator is driven as necessary to maintain the set desired speed.

NOTE: Default Value is 0.95, which will work with most engines and applications. Entering new values for these parameters is optional.

Diagnostics Calibration Parameters

Overspeed / Underspeed Protection

The overspeed protection feature shuts off the actuator when the engine runs above the overspeed RPM. Setting the OVERSPEED_PCNT value to zero disables this feature.

The underspeed protection feature shuts off the actuator when the engine RPM runs under the overspeed RPM. Set the UNDERSPEED_RUN_TIME value as desired. Setting the UNDERSPEED_RPM value to zero disables the underspeed protection feature.

When an engine overspeed / underspeed condition is detected, the engine protection control logic causes: (1) the actuator duty cycle to go immediately to zero and (2) a fault code activation that is signified by LED flashing. After engine protection control logic tripping, the fault code will continue to flash the LED. This signifies to the user that the engine stopped due to overspeed or underspeed engine conditions. The engine may later be restarted without resetting the unit; this action will cause the fault code to reset and the LED will then stop flashing.

Calibration Parameters Requiring Configuration:

OVERSPEED_PCNT
Critical engine speed for overspeed protection (RPM). The overspeed setpoint will be the current set speed plus the overspeed percentage.

\[
\text{Overspeed RPM} = \text{Desired RPM} \times (1 + \text{OVERSPEED_PCNT})
\]

Set OVERSPEED_PCNT to zero if overspeed protection is not desired. Normal closed-loop governing will decrease the duty cycle to the actuator any time engine speed is above the set point. Overspeed protection immediately shuts off the actuator when an overspeed condition is detected. Engine speed must be brought back to zero before the actuator is driven again. Setting OVERSPEED_PCNT to zero disables the overspeed protection feature. Default value: 0.25.

OVERSPEED_TIME
Time, in msec, that an overspeed condition must exist before a fault is latched. Default value: 250 msec.

UNDERSPEED_PCNT
Minimum engine speed used for underspeed shutdown. The underspeed setpoint will be the current set speed times the underspeed percentage.

\[
\text{Underspeed RPM} = \text{Desired RPM} \times \text{UNDERSPEED_PCNT}
\]

Normal closed-loop governing will increase the duty cycle to the actuator any time engine speed is below the set point. Underspeed shutdown immediately shuts off the actuator when an underspeed condition is detected. Engine speed must be brought back...
to zero before the actuator is driven again. Setting UNDERSPEED_PCNT to zero disables the underspeed protection feature.

**UNDERSPEED_TIME**
Time, in msec, that an underspeed condition must exist before a fault is latched. Default value: 2500msec.

**UNDERSPEED_RUN_TIME**
Amount of time the engine must be in run mode before underspeed shut down is activated (seconds).

How Does Overspeed Work?

The APECS 500 has the diagnostic capability to detect and react to an overspeed condition. The feature uses two programmable parameters, OVERSPEED_PCNT and OVERSPEED_TIME. Overspeed feature immediately shuts off the actuator when the engine runs above OVERSPEED_PCNT for OVERSPEED_TIME.

OVERSPEED_TIME is used to adjust the sensitivity. A large value will delay the shut down, and a small value will hasten it. A value as small as zero can be used, which means that the first occurrence of engine speed being over OVERSPEED_PCNT will result in a shut down. This is too sensitive and the engine could be shut down in the unlikely event that noise on the speed signal input caused a high miscalculation of engine speed. A minimum value of 250 msec is recommended. The user should realistically determine an overspeed tolerance time.

When an overspeed condition is detected, the duty cycle goes immediately to zero. This should stop the engine or at least drive it to minimum speed. A fault code is generated, and the LED flashes. The fault will continue to flash so that the user is made aware of why the engine stopped. The engine may be restarted without resetting the unit. The fault will then recover and stop flashing.

By default, overspeed is disabled. This is because a properly tuned PID governor will decrease the duty cycle to the actuator any time engine speed is above the set point. So ordinarily, overspeed is not necessary. It is disabled by setting OVERSPEED_PCNT to zero. However, if a user feels the need for a more aggressive response to an overspeed condition, the overspeed diagnostic feature may be used.

**Actuator Output Calibration Parameters**

The following calibration parameter requires configuration:

**DUTYCYCLE_OFFSET**
The total PWM duty cycle output to the actuator is the sum of the Proportional, Integral and Derivative branches plus an offset term, DUTYCYCLE_OFFSET. The integrator is always reset to zero at startup. Setting DUTYCYCLE_OFFSET to a non-zero value helps the transition from crank to run modes. Default value is 0.3
The APECS 500 is a user configurable engine speed governor and will follow your settings and commands immediately. It is possible to enter values in the APECS module that are in excess of what the engine is capable of performing and outside of safe operating range. It is the user's responsibility to pay attention when entering data into the APECS or the ACT. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment or application.
Step 4
Calibrate the selected features by configuring the listed parameters

Engine Cranking
- CRANK_DUTY_CYCLE: 0.95
- CRANK_2_RUN_PCNT: 0.90

Overspeed/Underspeed Protection
- OVERSPEED_PCNT
- UNDERSPEED_PCNT
- UNDERSPEED_RUN_TIME

Step 5
Calibrate any additional parameters, if needed.

Step 6
Adjust PID Gains
- DERIVATIVE_GAIN
- INTEGRAL_GAIN
- PROPORTIONAL_GAIN

RAMP_DOWN_RATE
RAMP_UP_RATE
WARMUP_PCNT
WARMUP_TIME

PID Gains too high
Integral gain too high or derivative gain too low

PID Gains too low
Derivative gain too high

Integral gain too low
Desired response
Chapter 4.
ACT Operation

ACT Installation

ACT Kit Contents

The All-purpose Calibration Tool (ACT) is used for programming (configuring and adjusting) and monitoring the APECS controller with your personal computer. The ACT kit contains the following:

- Software CD-ROM
- Interface module
- RS-232 connecting cable
- CD-ROM Installation Guide

Set-up Requirements

Hardware Requirements

- IBM compatible personal computer equipped with a CD-ROM drive and a serial port with DB-9 connector, capable of 9600 baud communication
- Windows software: 95/98/Me/2000/XP
- 64 MB of available RAM memory and a hard disk with at least 2.0 megabyte of free disk space
- SVGA capable video card and monitor, capable of 256 colors and 800 x 600 display

Software Requirements

CD-ROM of calibration tool software to run on your personal computer.
(CD supplied with ACT kit.)

Hardware Set-up

To connect your PC to the APECS 500 use the cable provided with the calibration tool kit. This cable has a DB-9 connector on one end and a four-pin white plastic Molex connector on the other end.

Connect one end of the RS-232 cable to your PC's COM port. Connect the other end of the cable to the control module.

NOTE: The APECS 500 must be powered up in order for ACT to operate.
Software Set-Up

ACT software can be automatically installed on your hard drive from the CD-ROM supplied with the kit. To install the software, follow the procedures below.

NOTE: Close all applications to prevent possible conflict between the ACT installer and other programs.

1. Turn on your computer and insert the ACT disk into the CD-ROM drive. The install program should automatically launch. If it does not, open Windows Explorer, go to the CD-ROM drive and double click on the install program.

2. Follow the prompts from the install program. You may select the default directory or specify your own.

3. When installation is complete, you may access the ACT software from the Start Menu or create your own shortcut.

4. The set-up is now complete and you are ready to run ACT.
   - To run the ACT software, please refer to “Running the ACT Software” in the following section.
   - Put the original CD-ROM in a safe place in case the files on your hard drive become damaged or lost.
Basic ACT Operation

Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the program.

1. Make certain that the APECS controller is powered up and connected to the computer’s COM port.

2. If an icon for the calibration tool exists, double click on it to start the ACT software. The license screen will be displayed when the ACT is launched. You must either accept the terms or Cancel, which exits the application.

3. If no icon exists, click on the Start button, highlight “Programs,” find the ACT software and click to start it. Default is Woodward, then select “APECS-EPS Calibration Tool.”

4. Make sure the COM port designation in ACT matches the serial port on the back of your PC.

5. Follow the procedure outlined in the Configure Menu to change the COM port assignment, if needed.

Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming communication procedures. It will close automatically when the procedure is complete.

Moving Around the Software

There are five main menu items available with ACT. Several options are available under each main menu item. The discussion in the following pages assumes the cursor is at the main menu screen.

- Use mouse to select or move around the menu.
- Use left mouse to execute a command or accept a condition.
- Use function key <F1> for HELP.
- A HOT key (highlighted character in a menu item) can also be used to access or activate a menu or sub-menu, e.g. File use <ALT> <F>.
- Click on the box in the upper right hand corner to exit ACT.
ACT Menus & Options

ACT Menu Structure

ACT’s five main menus—File Menu, Calibrate Menu, Monitor Menu, Configure Menu, and Help Menu have several options available under each. A complete discussion of all ACT menus and options is presented in the following pages.

<table>
<thead>
<tr>
<th>FILE MENU</th>
<th>CALIBRATE MENU</th>
<th>MONITOR MENU</th>
<th>CONFIGURE MENU</th>
<th>HELP MENU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save APECS Cal to File</td>
<td>Change APECS Calibration</td>
<td>Parameter View</td>
<td>Configure Serial Port</td>
<td>Help Topics</td>
</tr>
<tr>
<td>View Cal File Comments</td>
<td>Download Cal File to APECS</td>
<td>Parameter Plot</td>
<td></td>
<td>About ACT</td>
</tr>
<tr>
<td>View Text File</td>
<td>Compare APECS Cal to File Cal</td>
<td>Display Faults</td>
<td></td>
<td>User Manuals</td>
</tr>
<tr>
<td>Convert APECS Cal to Text</td>
<td>Change APECS Password</td>
<td>Control Strategy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convert Cal File to Text</td>
<td>APECS Calibration Wizard</td>
<td>Parameter List</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convert Cal File to Strategy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

File Menu

Purpose

The File Menu allows you to perform operations related to viewing, saving and converting files. The following commands are available under the File Menu.

- Save APECS Cal to File
- View Cal File Comments
- View Text File
- Convert APECS Cal to Text
- Convert Cal File to Text
- Convert Cal File to Strategy
Save APECS Cal to File

This command allows you to save APECS calibration data to a designated file. The ACT uploads the calibration set from the APECS controller and saves it to a computer file. This operation is usually done after the controller has been calibrated for satisfactory engine performance but can also be done at any other time. The data is saved in a binary file format that is not readable.

To Save APECS Cal to File:

1. Choose File → Save APECS Cal to File.

   ACT will prompt the path where the file will be saved:

2. Enter a file name to save the calibration data to.

   ACT will automatically append the file extension .ACT to the file name if you do not specify one. Click Save or press <Enter>.

   ACT will then read all of the current calibration values from the controller. This screen shows the progress.

   Once all the values are read, ACT will prompt you to add comments to the ACT file to aid in later identification.

3. If you click Yes, the comment editor screen will appear.

   To enter comments, type them one at a time and press <Enter> or click Save Edit. You can re-edit comments by clicking them, changing the text on the top line and clicking Save Edit. Comments can be deleted by clicking on them and then clicking “Delete” or by pressing <Del>.
4. Click OK on the comment editor or press <Enter> twice to save comments. Click Cancel or press <Esc> twice to close the window without saving comments. The Cal File will still be created if the comment editor is canceled.

5. The following message is displayed when the file is created successfully.

```
ACT
C:\Woodward\ACT Tool\Cal tool stuff 1.ACT Created Successfully
```

The file name in this message is the file selected in Step 2. ACT will save the calibration data to the designated file and display “Calibration Data Saved in File: ABCD.ACT” message (where ABCD is the name you entered in Step 2).

NOTE

The “Save APECS Cal to File” command stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file. See Convert APECS Cal to Text and Convert Cal File to Text commands.

View Cal File Comments

This command allows you to display the comments that are attached to a calibration file. Users add comments when saving a calibration file. The comments help in tracking specific engine, application, and environment data for which the calibration file was created.

To View Calibration Comments:

   ACT will display a list of files on the left side of the screen with file comments on the right:

2. Use the Up and Down arrow keys to highlight the desired calibration file (.ACT extension) and view the comments attached to that file.

3. Click OK or Cancel to close Comment Viewer. The comments are created or edited when the files are created.

View Text File

This command is a convenient way to view text files.

2. ACT will prompt for a text file to view.
3. Select a file and click OK.
4. ACT will open the selected file with the default viewer for that file type.
Convert Commands

The “Save APECS Cal to File” command, discussed earlier, stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file.

There are two convert commands available with ACT: “Convert APECS Cal to Text” and “Convert Cal File to Text.” The difference between the two commands is as follows:

1. In “Convert APECS Cal to Text” operation, the calibration set that is converted is from the APECS unit.
2. In “Convert Cal File to Text” operation, the calibration set that is converted is from a previously saved file.

You may use the View Text File command to view text files.

Convert APECS Cal to Text

This command allows you to create a text file of APECS calibration data for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

To Convert APECS Calibration to Text:

1. Choose File → Convert APECS Cal to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK. ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a text file for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

To Convert Cal File to Text:

1. Choose File → Convert Cal File to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK. ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have a different control strategy version.

ACT will:

1. Parse through all of the calibration parameters in the old ACT file.
2. Search for the same calibration parameters in the new ACT file and assign values from the old calibration.
To Convert a Cal File to a New Strategy:

2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
   ACT will read all of the calibration values from the controller create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Calibrate Menu

The Calibrate Menu allows you to perform operations related to APECS calibration. The following commands are available:

- Change APECS Calibration*
- Download Cal File to APECS*
- Compare APECS Cal to File Cal
- Change APECS Password*
- APECS Calibration Wizard*

(*) These commands can be password protected to prevent unauthorized calibration changes. See “Change APECS Password” for more information.

Change APECS Calibration

The “Change APECS Calibration” command allows you to calibrate (configure and adjust) various parameters associated with the APECS controller.

APECS 500 is a programmable engine governor. Changing APECS calibration parameters is the means to configure the APECS controller for specific engines, applications and environments, and for adjusting PID gains.

The calibration parameters have been organized into categories for your convenience. Browse through the categories to view the specific parameter you want to change or adjust.

Some parameters must be set before the engine can run. Other parameters can be adjusted while the engine is running. A complete list of parameters appears in “Understanding APECS Calibration” in Chapter 3.

All adjustments are stored immediately in non-volatile memory in the APECS unit. The APECS controller will retain the changes even if power is lost or the ACT is disconnected.

To Change APECS Calibration Parameters:

1. Choose Calibrate ➔ Change APECS Calibration.
2. Set the “View Filter” to select a group of parameters.
3. Use F5/F6 to scroll through the list.
4. To change the highlighted parameter:
   Enter the new value in the “New Value” field
   Press <Enter>
The new value is written to the controller and then read back, with the result placed in the “APECS Value” field.

5. Press <Esc> to exit.

Download Cal File to APECS

The “Download Cal File to APECS” command allows you to download the entire calibration set from a file to the APECS permanent memory. This is a convenient one-step method for:

- Reverting back to a known good calibration set after experimenting with new calibration settings
- Programming multiple APECS units for a particular application

The downloaded file may have been previously configured and calibrated for satisfactory engine performance with another APECS unit.

To Download a Cal File to APECS:

1. Choose Calibrate → Download Cal File to APECS. The following screen allows you to select a Cal file to download.

2. Choose a file and click OK. The following screen will show the progress.

3. The following screen is shown when the operation is complete.
NOTE: During the “Download Cal File to APECS” operation, the user may encounter a situation where the Cal File password is different from that of the APECS unit. If this happens, please refer to the steps below to complete the download operation.

To Download a Cal File to APECS with a Password Different from that of the APECS Unit:

Whenever the APECS password is added or changed, the new password is stored in the unit as well as in any calibration file saved after the change.

During a “Download Cal File to APECS” operation, if the password stored in the calibration file matches the password in the unit, ACT will readily download the calibration to the APECS unit.

However, if the password stored in the calibration file does not match the password in the APECS unit, ACT will alert you of a password mismatch. Please follow the steps below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal File password differs from that of the APECS unit. Download the Cal File password to the APECS unit?”

2. If you answer Yes to this message (see note below), the calibration file will be downloaded and the password in the APECS unit will be changed to match the password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded but the password in the unit will remain unchanged.

NOTE
Before answering Yes to the message, make sure you know the password in the calibration file. If you do not know the password, you will not be able to access the password protected features under the Calibrate menu.

Please see “Change APECS Password” command for more information on password protection.

Compare APECS Cal to File Cal

This command lets you check the differences in calibration sets between a saved file and the APECS unit. The feature is useful, for example, to ensure that the saved file matches the calibration in the APECS unit.

To Compare APECS Cal to File Cal:

1. Choose File  Comparing APECS Cal to File Cal. This screen allows you to select a Cal File to compare.
2. Choose a file and Click OK. This screen will show the progress.

3. Once all parameters have been processed, a message box will list the compare results. If the parameters in the file match the controller, the following message box appears:

4. Click OK to close. If there were mismatches, the following message will appear:

You may select “Save to File” if you would like to save a permanent record of the file compare. You will then be asked to select a destination directory and file name.

Change APECS Password

This command allows you to add or change a password to protect certain calibration features. The option is useful, for example, to prevent unauthorized changes to a known good calibration set in the APECS unit.

By default, the APECS unit is not password protected.

To Change APECS Password:

1. Choose Calibrate → Change APECS Password. You will be prompted for the current password.
2. The application will query the controller to verify that the entered password matches the current password. If the password matches, the “Change” button is enabled:

3. Click “Change” and the application will prompt for the new password:

4. Enter the new password. It should be one word, no spaces, and up to 11 characters long. Once entered, click OK. The application will prompt to re-enter the password to make sure that it was typed in properly:

5. Re-enter the password and click OK. If the two entries of the new password are equal, the new password will be encoded and saved in the controller.

Passwords are upper and lower case sensitive.

After changing your password, please record it in a safe place for future reference. To revert to no password protection, change APECS password to “peg,” which is the default password.

ACT Operation with the New Password:

Once a password is added or changed, the following calibration features become password protected:

- Change APECS Calibration
- Download Cal File to APECS
- Change APECS Password
- APECS Calibration Wizard

At the start of any future sessions, ACT will always prompt you to enter the new password to gain access to these features. You only need to enter the password once during any session to gain access to all the password protected features.
APECS Calibration Wizard

The APECS Calibration Wizard is an interactive guide to help you get your controller unit up and running as quickly as possible.

To Calibrate a Controller Unit Using the APECS Calibration Wizard:

1. Choose Calibrate \(\rightarrow\) Calibration Wizard.

2. The Wizard will give you the option to use the default calibration or modify the existing one. If you select the default calibration, the Wizard will reset all calibration parameters.

3. Press <Enter> to continue or <Esc> to abort the Wizard.
   
   If you press <Enter> the Wizard will lead you through the calibration process with a series of questions. When all questions have been answered the Wizard will ask you to confirm that the values entered are accurate.

4. Press <Enter> to confirm the values, <PgUp> to go back and change the values, or <Esc> to abort the Wizard.

   If you press <Enter>, the APECS Wizard will download the new calibration and reset all APECS parameters. This will complete the APECS Wizard operation.

   **NOTE:** The APECS Calibration Wizard only covers basic calibration. It does not automatically assure optimum engine operation. Please refer to APECS Calibration Procedures for more information.

5. You are now ready to run your engine. Press any key to go directly to the Parameter Plot screen where you can adjust the PID gains.
Monitor Menu

The Monitor Menu allows you to observe engine and APECS operation in real time. The following commands are available under the Monitor Menu.

- Parameter View
- Parameter Plot
- Display Faults
- Control Strategy
- Parameter List

Parameter View

This command allows you to view certain operating variables (i.e., engine speed) in real time.

To View Parameter Values in Real Time:

1. Choose Monitor → Parameter View. The application will launch the view screen.

2. The screen automatically starts reading values from the controller and displaying the values.

3. To stop the updating, click on Stop. The button name will then change to ‘Start.’ Clicking it again will start updating again.

NOTE
If any other screen is opened that requires communication with the controller while the screen is updating, the Parameter View screen will be automatically stopped.
Parameter Plot

The Parameter Plot command lets you view engine performance on screen in the form of a real-time graph. This feature allows you to perturb the system and observe the response to fine tune engine performance.

To View Parameter Plot in Real Time:

Select Monitor → Parameter Plot. The application will launch and start the parameter plot view.

The application will read the previously saved configuration and request the controller to start sending the parameter values. The controller sends the data to the PC at a rate that varies with the number of parameters being monitored. The application uses the Windows timer functionality to update the screen at the specified rate. Note that if the PC is very busy, the timer accuracy will vary; therefore, the screen and generated data files should be considered as reference only.

The X-axis time scale (25 seconds in the example screen) may be shorter than configured due to the resolution of the monitor. This value will be adjusted when the graph is resized. This also applies to the print functionality for this screen. All of the data will be recorded in a revolving buffer for use by the “Save to File” feature (see below).

The axis scales, parameter names, update resolution and time scale on the Parameter Plot may be changed as described in the Plot Setup screen.

PID Gain Adjustments from Plot Display Screen

After initial calibration, most engines require only a minor adjustment to PID gains to fine tune the system to its optimum level. ACT provides a convenient means of adjusting the PID gains directly from the Plot Display screen.

To Make PID Gain Adjustments from Plot Display Screen:

1. Press the letter <P> for proportional, <I> for integral, or <D> for derivative gain adjustment. The application will enable the gain you selected.
2. Use the Up or Down arrow keys to increase or decrease the present value. The arrow keys adjust the values by 0.004. New values may be typed in directly. Hit <Enter> after you type in a value. The application will save the new value in the APECS unit.
3. Press <Esc> to deselect the gain adjustments.

To Change Plot Setup:

This allows you to choose engine RPM, desired engine speed, duty cycle or any other parameter for viewing real-time plots on screen. Axis scales can also be adjusted to fit the parameter and/or speed.
1. On the Parameter Plot screen, click on “Configure.” The application will show the following screen with the current values.

![Plot Setup Window]

**Plot 1 / Plot 2**
Use the pull-down to select the desired parameter to plot.

**Axis Min / Max**
Enter the minimum / maximum value for the parameter value.

**X Axis Time Scale**
Controls how much data is displayed on the X axis. This value may automatically adjust for screen resolution.

**X Axis Sample Rate**
Controls how often the data from the controller is used to update the screen. Data received between timer ticks is discarded.

2. Clicking OK will save this information in the Windows Registry so that it will be remembered the next time the program is started.

**NOTE:** The Calibration Wizard will automatically set up the plots if there are no saved defaults.

**Display Faults**

This command allows you to display present faults in real-time. This means if new faults occur while you are monitoring, the screen will automatically update to display the current faults. The display will also show historical fault codes that have been previously logged but do not currently exist. Historical fault codes are helpful when tracking down intermittent faults.

**To Display Faults in Real Time:**

1. Choose Monitor → Display Faults from the main menu. The application will launch the Fault view.

The application will update the display every time the controller sends the fault_flags status. This happens several times a second.
2. Click on the “Pause” button to stop the automatic update of this screen. The text on the button will change to “Start” and clicking it again will re-start the automatic updating.

**NOTE:** If any other screen requests data from the controller while this screen is updating, this screen will automatically Pause.

**Control Strategy**

This command allows you to check the version of the control strategy in use. This information may be needed for strategy identification purposes and for future updates.

**Parameter List**

The Parameter List screen allows the user to adjust which parameters are displayed on the Parameter View display.

**To Display the Parameter List:**

1. Choose Monitor > Parameter List from the main menu.

2. The F5/F6 keys will backup/advance through the list. Press F9 or click on “On View List” to toggle the selected parameter on the Parameter View screen.

3. Click on the x box in the title bar or press <Esc> to close the screen. Edits are not saved between application launches.

4. If the Parameter View screen is already open when changes are made to the view list, close the Parameter View screen and re-open it to make the changes effective.

**Save**

Clicking Save will prompt the user for a file name to save the currently viewed configuration to.

Type in a file name that reflects the purpose of the saved configuration and click Save. The view configuration dialog will now display the selected file name in the title bar.

**Open**

Clicking Open will prompt the user for a file name of a previously saved View Configuration. Select the desired file and click Open. The View Configuration will be updated with the saved parameters.
The ACT application will always recall the default set of plot configuration parameters at application startup, and does not recall the last used view setup file. So the view configuration will always start with the default view.

Several parameter view screens can be open with different configurations by changing the configuration on the parameter list screen (F9 or Open), then opening a new Parameter View.

**NOTE:** Only one of the parameter view screens can be monitoring the controller at once.

### Configure Menu

#### Configure Serial Port

This command allows you to designate the proper COM port for your PC to enable communication between the ACT and the APECS controller.

**To Configure the Serial Port:**

1. From the main menu screen, choose Configure → Custom Serial Port. The application will display the following screen:

2. Choose a port and click OK. This screen will be displayed on application startup if a controller cannot be found at the last selected port and can be changed any time after the application has started.

#### Demo Mode

This mode will use a calibration file “Demo.000” and use random numbers for values requested from the controller.

**COM 1 / COM 2**

This mode will look for a controller attached to the selected serial port. An error message will be displayed AFTER you click OK if a controller cannot be found or if the port cannot be opened.

COM ports outside of this range can be used by editing the default COM port registry key for this application.
Help Menu

The Help Menu provides access to the online user’s manual and other information helpful to your use of the calibration tool. The following commands are available under the Help Menu:

- Help Topics
- About ACT
- User’s Manual

Help Topics

This command allows you to search for specific information by displaying software menu items or through key words.

1. Click on “Contents” for an outline of the software applications listed by menu items.
2. Click on “Index” or “Find” to locate a specific topic through an alphabetical listing or by typing in a word or phrase.
3. Follow the on-screen commands to page through the manual.

About ACT

This command displays the version of the calibration tool that you are currently using. This information is important for tool identification purposes and for servicing support.

User’s Manual

This command accesses the User’s Manual, which includes comprehensive information on the APECS 500 controller, wiring diagrams, ACT software menus, and calibration parameters. The manual may be viewed online or printed for future reference.
Chapter 5.
Troubleshooting

General Checklist

Please follow the checklist below to troubleshoot your APECS controller.

We recommend using a digital multimeter capable of measuring frequency and duty cycle such as a Fluke 87.

1. Check battery voltage for stability and correct value. The LED will turn on for one second when the APECS 500 is first powered up.

2. For magnetic pickups, check that the speed signal is at least 2 V\text{rms} using the AC volt settings on voltmeter. Actuator should go to full travel during cranking. The LED will illuminate when it senses an engine speed.

3. Check the actuator linkage for binding and backlash.

4. Check that the actuator has sufficient force to reach the starting and rated load positions.

5. Confirm normal operation of engine under manual control.

6. Confirm that the load (e.g., voltage regulator on generator) is not inducing instability.

7. Try adjusting the gains to achieve stability.

Fault Codes

The APECS 500 controller is capable of identifying certain fault conditions and alerting the user to them. A flashing LED indicates the fault conditions. The current fault code list is shown in Table 6. Please note the following:

1. When power is first applied to the controller, the LED will flash just once for one second to indicate that the LED is working.

2. If there are multiple faults, the LED will flash them all in sequence. Count the flash codes to determine the fault conditions or connect the calibration tool to observe the fault conditions. (Use the “Display Faults” option under the Monitor Menu.)

3. If there are no faults, the LED will flash once at reset and from then on indicate the detection of engine speed. A continuous ON LED indicates that a valid engine speed is being sensed.

4. The controller will attempt to shut down for some faults and will not permit starting after reset with faults 1, 5 and 8.
<table>
<thead>
<tr>
<th>FLASH CODE</th>
<th>FAULT</th>
<th>ENGINE SHUTDOWN</th>
<th>CORRECTIVE ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>APECS unit not calibrated</td>
<td>Yes</td>
<td>Calibrate PULSES_PER_REV.</td>
</tr>
<tr>
<td>2</td>
<td>Engine speed excessive</td>
<td>Yes</td>
<td>Check parameter settings. Overspeed criteria may be too sensitive. Check for electrical noise entering controller. Check wiring and connections. Check case ground. Make sure linkage moves freely, without backlash. Check tip of speed sensor.</td>
</tr>
<tr>
<td>3</td>
<td>Engine speed unusually low</td>
<td>Yes</td>
<td>Check parameter settings. Check linkage and the actuator travel. Ensure that load is not greater than engine capacity.</td>
</tr>
<tr>
<td>4</td>
<td>Actuator disconnected, open circuit or short circuit</td>
<td>Yes</td>
<td>Check actuator wiring and actuator resistance. Resistance should be less than 10 ohms.</td>
</tr>
<tr>
<td>5</td>
<td>Factory settings lost</td>
<td>Yes</td>
<td>If calibration file is available, download calibration file and cycle power again. If controller still does not work or if no calibration file is available, consult factory.</td>
</tr>
<tr>
<td>6</td>
<td>Speed set pot out-of-range</td>
<td>Defaults to minimum speed</td>
<td>Consult factory.</td>
</tr>
<tr>
<td>7</td>
<td>Gain set pot out of range</td>
<td>Yes</td>
<td>Consult factory.</td>
</tr>
<tr>
<td>8</td>
<td>Controller unit failed</td>
<td>Yes</td>
<td>Electrical noise may be entering controller. Check wiring, shielding and connections to controller. Cycle power to engine. If controller still does not work, consult factory.</td>
</tr>
</tbody>
</table>
Glossary of Technical Terms

ACT (All-purpose Calibration Tool) Software
PC software program for configuring and calibrating the APECS controller

Actuator
Device that converts an electrical signal from the APECS controller to an output shaft position

APECS (Advanced Proportional Engine Control System)
Engine governing system developed by Woodward

Cal File
File containing APECS calibration data

Cal Tool Version
The version of calibration tool software in use

Calibration
Process of configuring and adjusting the controller to work with a specific application

Calibration Wizard
Interactive software guide to help you set up basic calibration and get the controller in operation quickly

Control Strategy
The version of software residing in the controller

Duty Cycle
Percentage of time a pulse width modulated (PWM) signal remains on

Parameter
Numerical value that helps the user calibrate the APECS controller

PWM (Pulse Width Modulation)
Means of simulating analog output with a digital device. The PWM duty cycle determines the equivalent analog output: the higher the duty cycle, the higher the equivalent analog output. A PWM signal is used by APECS to drive the actuator.

Speed Sensor
Device such as a magnetic pickup that senses engine speed
Chapter 6.
Service Options

Product Service Options

The following factory options are available for servicing Woodward equipment, based on the standard Woodward Product and Service Warranty (5-01-1205) that is in effect at the time the product is purchased from Woodward or the service is performed:

- Replacement/Exchange (24-hour service)
- Flat Rate Repair
- Flat Rate Remanufacture

If you are experiencing problems with installation or unsatisfactory performance of an installed system, the following options are available:

- Consult the troubleshooting guide in the manual.
- Contact Woodward technical assistance (see “How to Contact Woodward” later in this chapter) and discuss your problem. In most cases, your problem can be resolved over the phone. If not, you can select which course of action you wish to pursue based on the available services listed in this section.

Replacement/Exchange

Replacement/Exchange is a premium program designed for the user who is in need of immediate service. It allows you to request and receive a like-new replacement unit in minimum time (usually within 24 hours of the request), providing a suitable unit is available at the time of the request, thereby minimizing costly downtime. This is also a flat rate structured program and includes the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205).

This option allows you to call in the event of an unexpected outage, or in advance of a scheduled outage, to request a replacement control unit. If the unit is available at the time of the call, it can usually be shipped out within 24 hours. You replace your field control unit with the like-new replacement and return the field unit to the Woodward facility as explained below (see “Returning Equipment for Repair” later in this chapter).

Charges for the Replacement/Exchange service are based on a flat rate plus shipping expenses. You are invoiced the flat rate replacement/exchange charge plus a core charge at the time the replacement unit is shipped. If the core (field unit) is returned to Woodward within 60 days, Woodward will issue a credit for the core charge. [The core charge is the average difference between the flat rate replacement/exchange charge and the current list price of a new unit.]

Return Shipment Authorization Label. To ensure prompt receipt of the core, and avoid additional charges, the package must be properly marked. A return authorization label is included with every Replacement/Exchange unit that leaves Woodward. The core should be repackaged and the return authorization label affixed to the outside of the package. Without the authorization label, receipt of the returned core could be delayed and cause additional charges to be applied.
Flat Rate Repair

Flat Rate Repair is available for the majority of standard products in the field. This program offers you repair service for your products with the advantage of knowing in advance what the cost will be. All repair work carries the standard Woodward service warranty (Woodward Product and Service Warranty 5-01-1205) on replaced parts and labor.

Flat Rate Remanufacture

Flat Rate Remanufacture is very similar to the Flat Rate Repair option with the exception that the unit will be returned to you in “like-new” condition and carry with it the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205). This option is applicable to mechanical products only.

Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned to Woodward for repair, please contact Woodward in advance to obtain a Return Authorization Number. When shipping the item(s), attach a tag with the following information:

- name and location where the control is installed;
- name and phone number of contact person;
- complete Woodward part number(s) and serial number(s);
- description of the problem;
- instructions describing the desired type of repair.

CAUTION

To prevent damage to electronic components caused by improper handling, read and observe the precautions in Woodward manual 82715, Guide for Handling and Protection of Electronic Controls, Printed Circuit Boards, and Modules.

Packing a Control

Use the following materials when returning a complete control:

- protective caps on any connectors;
- antistatic protective bags on all electronic modules;
- packing materials that will not damage the surface of the unit;
- at least 100 mm (4 inches) of tightly packed, industry-approved packing material;
- a packing carton with double walls;
- a strong tape around the outside of the carton for increased strength.
Return Authorization Number

When returning equipment to Woodward, please telephone and ask for the Customer Service Department [1 (800) 523-2831 in North America or +1 (970) 482-5811]. They will help expedite the processing of your order through our distributors or local service facility. To expedite the repair process, contact Woodward in advance to obtain a Return Authorization Number, and arrange for issue of a purchase order for the item(s) to be repaired. No work can be started until a purchase order is received.

NOTE
We highly recommend that you make arrangement in advance for return shipments. Contact a Woodward customer service representative at 1 (800) 523-2831 in North America or +1 (970) 482-5811 for instructions and for a Return Authorization Number.

Replacement Parts

When ordering replacement parts for controls, include the following information:
- the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
- the unit serial number, which is also on the nameplate.

How to Contact Woodward

In North America use the following address when shipping or corresponding:
Woodward Governor Company
PO Box 1519
1000 East Drake Rd
Fort Collins CO 80522-1519, USA

Telephone—1 (970) 482-5811 (24 hours a day)
Toll-free Phone (in North America)—1 (800) 523-2831
Fax—1 (970) 498-3058

For assistance outside North America, call one of the following international Woodward facilities to obtain the address and phone number of the facility nearest your location where you will be able to get information and service.

<table>
<thead>
<tr>
<th>Facility</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazil</td>
<td>+55 (19) 3708 4800</td>
</tr>
<tr>
<td>India</td>
<td>+91 (129) 230 7111</td>
</tr>
<tr>
<td>Japan</td>
<td>+81 (476) 93-4661</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>+31 (23) 5661111</td>
</tr>
</tbody>
</table>

You can also contact the Woodward Customer Service Department or consult our worldwide directory on Woodward’s website (www.woodward.com) for the name of your nearest Woodward distributor or service facility. [For worldwide directory information, go to www.woodward.com/ic/locations.]
Engineering Services

Woodward Industrial Controls Engineering Services offers the following after-sales support for Woodward products. For these services, you can contact us by telephone, by email, or through the Woodward website.

- Technical Support
- Product Training
- Field Service

Contact information:
  Telephone: +1 (847) 967-7730
  Email: info_niles@woodward.com
  Website: www.woodward.com/ic

**Technical Support** is available through our many worldwide locations or our authorized distributors, depending upon the product. This service can assist you with technical questions or problem solving during normal business hours. Emergency assistance is also available during non-business hours by phoning our toll-free number and stating the urgency of your problem. For technical support, please contact us via telephone, email us, or use our website and reference *Customer Services* and then *Technical Support*.

**Product Training** is available at many of our worldwide locations (standard classes). We also offer customized classes, which can be tailored to your needs and can be held at one of our locations or at your site. This training, conducted by experienced personnel, will assure that you will be able to maintain system reliability and availability. For information concerning training, please contact us via telephone, email us, or use our website and reference *Customer Services* and then *Product Training*.

**Field Service** engineering on-site support is available, depending on the product and location, from one of our many worldwide locations or from one of our authorized distributors. The field engineers are experienced both on Woodward products as well as on much of the non-Woodward equipment with which our products interface. For field service engineering assistance, please contact us via telephone, email us, or use our website and reference *Customer Services* and then *Technical Support*. 
Technical Assistance

If you need to telephone for technical assistance, you will need to provide the following information. Please write it down here before phoning:

**General**

Your Name

Site Location

Phone Number

Fax Number

**Prime Mover Information**

Engine/Turbine Model Number

Manufacturer

Number of Cylinders (if applicable)

Type of Fuel (gas, gaseous, steam, etc)

Rating

Application

**Control/Governor Information**

Please list all Woodward governors, actuators, and electronic controls in your system:

<table>
<thead>
<tr>
<th>Woodward Part Number and Revision Letter</th>
<th>Control Description or Governor Type</th>
<th>Serial Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Woodward Part Number and Revision Letter</th>
<th>Control Description or Governor Type</th>
<th>Serial Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Woodward Part Number and Revision Letter</th>
<th>Control Description or Governor Type</th>
<th>Serial Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you have an electronic or programmable control, please have the adjustment setting positions or the menu settings written down and with you at the time of the call.